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Introduction
Welcome to BioImageXD, free open source software for biomedical image
post-processing, visualization and analysis. This guide will help you get
started, providing an overview of the most important features and
functions. Please send us your feedback and questions to
info@bioimagexd.net.

Remarks
•
•

•
•

It is recommended to give BioImageXD time to finish things
“in peace” before “clicking further”, as some tasks are
demanding for regular computers.
With some older 32-bit operating systems it may be advisable
to restart the program between demanding processing steps,
as these operating systems have somewhat problematic
memory handling.
In problem situations first restart the software and try again;
if the problem persists, tell us about it (send email or click
Report bug in the Help menu)
Important terminology:
o Dataset = multidimensional image file that can consist
of multiple slices (such as the optical sections from a
confocal microscope that make up a 3D volume),
multiple timepoints and multiple channels
o Channel = subset in a dataset; all channels show the
same image data but somehow differently, for
instance different fluorescent markers can constitute
different channels.

User interface
In the main window there is a file tree of loaded files on the left, currently
active visualization in the middle (called the View panel) and settings for
currently active task on the right (displaying channel information if no task
is selected). At the top is the main toolbar with buttons in four groups (from
left): file input/output functions, tasks, visualization modes, special
features. Some tools and settings have a reddish color – these are for more
advanced use and are mostly not needed in basic use.
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Selecting data.

From the file tree data is selected both for viewing
and for processing it with tasks. More than one channel (“file”) can be
selected by CTRL/SHIFT-clicking. Different visualization modes and different
tasks accept/require different numbers of channels to be chosen. All
visualization modes except 3D mode display only one channel, even if
several are chosen (except if some task is active, which allows displaying
more than one channel). Different tasks accept channels as follows: Adjust –
only one channel allowed; Merge – two or more channels required;
Colocalization – two channels required; Procedure list – typically one
channel, but does accept more; Batch processor – unlimited, accepts also
several datasets at the same time. See sections below for more details on
different visualization modes and tasks.
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Opening files
Click Open dataset to open volume datasets in any of the supported file
formats, meaning especially microscopy file formats like LSM (Zeiss), OIF
(Olympus) or LIF (Leica), and BioImageXD’s own file format BXD.
For opening “regular” image files like JPEG and TIFF, use Import images
(also handles volume stacks and timepoints):
1) Go to the folder containing the images from the Browse button, and
choose one image (doesn’t matter which one) from among the ones
you wish to import. Tip: All images you want to import as one
dataset must be in the same directory and have the same
dimensions, and they should all have the same file name prefix, with
a running number starting from 1 (or another small number) at the
end of the file name.
2) Choose whether to import “All files in same directory” or “Files
following pattern” (in the latter case alter the suggested file name
pattern if necessary) and click Update. Tip: it might be easiest to put
the images for each dataset into their own folders (with no other
content in the folders) and use the “All files in same directory”
option.
3) “List of Input Data” lists the images about to be imported. If you do
not wish to import all of them, choose the one(s) you want by clicking
them (choose several by SHIFT/CTRL-clicking).
4) Specify “Volume information”. This information is required for
correct image visualization and processing, and must be entered by
the user when opening regular image files, from which it cannot be
read automatically.
5) Click OK, and a BioImageXD dataset (BXD) is created from the chosen
images, and opened into BioImageXD. If importing RGB color images,
the dataset will contain 4 channels (1 color channel + 3 greyscale
channels for the components R, G and B). Note that many features of
BioImageXD require a greyscale channel, rather than the color
channel, to be used as input.
Opened datasets appear into the internal file tree, with each channel as a
separate “file”. Datasets in the tree are not read into memory upon loading,
but only as needed while working with them. It is therefore possible to
instantly open numerous files into the tree. The tree can be toggled
visible/invisible from its tool bar button. Datasets can be removed from the
tree by right-clicking them. When exiting the program, you are asked
whether you want to save the file tree for the next time the program starts
(note: this does not save any of the datasets themselves, only information of
which datasets are listed in the file tree).
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Viewing files
Choose any one channel from the file tree, and it is visualized in the view
panel. Choose between any of the five visualization modes: Slices (default),
Gallery, Orthogonal, Projection or full 3D rendering. One (and only one) of
these is always selected. Sliders on the sides of the image are used to switch
between timepoints and z-slices when applicable, and controls for zooming
are at the top. For some visualization modes additional settings appear to
the left side of the view panel.

Creating 3D rendering
The 3D mode is based on rendering modules, listed at the top of the
settings panel appearing to the left of the view panel. Choose a
module from the drop-down menu and click Load to add it to the
list. Several modules can be active at the same time. Click on a
loaded module and its settings appear. Click Apply at the bottom to
see the effect of any changes to the settings, if the screen is not
automatically updated. The most typical modules are Volume
rendering and Surface rendering, and their most important
settings are shown below.
To visualize multiple channels at the same time: Choose the
channels from the file tree, then go to 3D mode, where you can
specify which channel is used for input for each rendering module.
You can for instance visualize one fluorescence channel as volume
rendering and another as surface rendering.

Tasks
Tasks are used to do something to the selected images, not just to visualize
them. The four main tasks are Adjust, Merge, Colocalization, and
Procedure list. Pressing its button activates the task, pressing it again
deactivates it. Only one task can be active at a time, but no task has to be
selected. The settings of the active task appear to the right. Click View
result at the bottom to see the effect of any changes to the settings, if the
screen is not automatically updated. To keep any changes made, save them
as a new dataset from Save dataset (if you don’t do this, the changes are
not kept once you exit the task). This creates a new BXD file that
automatically appears into the file tree. Slices and Projection visualization
modes are recommended starting points when working with tasks. When a
task is active you can change the dataset(s) it processes by choosing them
from the file tree and clicking Apply change.

BioImageXD – Getting started

Adjust task.

Used to change the intensity transfer function, which
adjust parameters like brightness and contrast, for a single channel. The
transfer function is shown graphically and the most important controls are
the sliders around it for Contrast, Brightness and Gamma.

Merge task.

Used to combine several channels, mainly for two
purposes: 1) to view several channels simultaneously (by activating the task)
and 2) to create 32-bit RGBA color datasets (by Save dataset when the task
is active). The settings have a graphical intensity transfer function very
similar to the Adjust task, for adjusting how bright etc. each channel will
appear in the merged image. Channel selection buttons at the top
determine the channel whose transfer function is being adjusted, whereas
similar channel selection buttons on the right side of the image toggle the
display of the channels on and off. Tip: an RGBA color dataset can be
volume rendered in 3D mode, but not surface rendered.

Colocalization task.

Used to analyze colocalization between two
channels. First adjust thresholds manually at the top, or click Calculate
thresholds to adjust them automatically. Then click Calculate statistics to
see the quantitative result, which can be saved as a CSV file from the
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Export button. If you want to calculate also P-value, choose the appropriate
method before clicking Calculate statistics. The 2D histogram can be saved
by right-clicking it. The three channel selection buttons on the right side of
the image toggle the display of the original channels and the colocalization
map on and off.

Procedure list task.

Does “everything else”, from noise filtering to
segmentation to tracking. Can take as input one or several channels. Create
a list of procedures by selecting them from the categorized menu buttons
below the list. Clicking on a procedure displays its settings, and a brief
description of the procedure, including acceptable inputs and outputs. Click
View result to test the execution of the whole list, and Save dataset to
execute the list into a BXD file. The inputs and outputs vary between
procedures, and both can consist of image data and/or quantitative results
in the form of CSV files. Procedure lists can be saved and loaded by clicking
Presets. The channel selection buttons on the right side of the image toggle
the display of the original channels and the outcome of the procedure list on
and off. Tip: If you want the resulting dataset to contain more than one
channel (for instance if you want to crop all channels of a dataset to a
defined region of interest), use the Batch processor, because the Procedure
list task can only output datasets with one channel.

Segmentation
Typically segmentation consists of several steps in the procedure list, for
instance as follows:
1. Hybrid median 2D (or some other noise filtering).
2. Threshold (or some other segmentation method that separates
image material of interest from the background; the settings for
this are critical for successful segmentation).
3. Connected component labeling or Object separation (these
separate the segmented material into objects that are given
identifying colors and that can be quantified; Object separation is
more complex of the two, capable of separating objects that touch
each other).
4. Analyze segmented objects (quantitatively analyzes the
segmented objects for number, volume, area, intensity etc.).

Saving files
•

To save a multidimensional volume dataset (can only be done in the
BXD file format), click Save dataset. This needs to be done to save
the results of a task before closing/changing it. A dataset may also be
saved without any task active, for instance to just save it with a
different color palette (see Color palette below)
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•

•
•

To save the image visible in the View panel at any time, click Save
snapshot image (the camera button). This saves a 2D color image of
the whole visualization with the zoom level specified (also image
areas that do not fit into view are saved)
To save a dataset as a series of 2D images (PNG, JPEG, TIFF or OMETIFF) use Export images in the File menu
To save a movie file of a 3D rendering, use the Animator (see
Creating an animation below)

Tracking
Motion tracking is an example of a more complicated procedure that
requires several different procedure lists. It is carried out as follows
(each step is its own procedure list):
1. Segment and analyze (see box above) the objects whose motion
over time you wish to track.
2. Perform tracking with Create motion tracks. In its settings first
choose the results file from the previous step into Objects file,
then click Read objects and finally click Calculate tracks and
export result. The settings for tracking are critical to its success,
and are mostly determined by trial and error.
3. Analyze the tracks for quantitative results such as speed of
movement with Analyze motion tracks. In its settings, choose the
results file from the previous step into Tracks file. Perform
calculation and save results as csv file by clicking Analyze tracks
and export statistics.
4. If you want to visualize the tracks in a 2D view mode, choose
Visualize motion tracks. In its settings, choose the results file
from step 2 into Tracks file, and then click Read tracks. Choose
the tracks to visualize from the list.
5. If you want to visualize the tracks in 3D, Procedure list task is not
used. Simply load the module Visualize motion tracks in the 3D
mode. Its settings are similar to those of 2D Visualize motion
tracks above.

Batch processor
Used for processing more than one dataset in one go (can also be used to
process several channels of a single dataset). Choose the datasets you want
to process from the file tree, then activate Batch processor from the Tasks
menu or by clicking CTRL-B. The batch processor is very similar to the
Procedure list task, except that you can specify several different procedure
lists, for instance to process different channels differently.
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How to use Batch processor
•

•
•
•

•

Choose Each channel separately for all channels to be processed
separately through every Procedure list, or All channels as input
for all channels to be given as input to every Procedure list.
Channels can be grouped into datasets by ticking the appropriate
check-box.
Click Add to add the required number of Procedure lists. Click on
the list to give it a name and to specify its procedures as you
would in Procedure list task. Check input for every Procedure list.
If the desired output for a Procedure list is a quantitative result,
click on the (Click to define) to see a list of possible variables.
Choose the ones you want in your aggregated results file.
Start batch processing by clicking Run! (The program asks for a
name for the file into which possible quantitative results are
aggregated. If there are none, ignore this.) The processing may
take a long time and the program may seem unresponsive during
it.
You can save and open Batch analyses from the File menu in the
Batch processor.

Creating animation
Make sure no task is selected, then go to 3D mode and set up the
visualization you want to animate. Then activate the animator. First set
Rendering parameters like duration and frame rate, then click Use
settings. The animator is based on three kinds of tracks: Timepoints,
Camera Path and Keyframe, the latter two being two different animation
techniques. Click on the buttons to add tracks as required. Then drag and
drop items to the desired positions in these tracks from the corresponding
buttons. Items in the tracks can be moved and resized, and additional
controls are available in the Animation menu. When the animation is set up,
click Create animation to create the video. The PAL-DVD and NTSC-DVD
presets are the easiest options here. Click Ok to render the video, and wait
for the computer to finish the process. Animation projects can be saved and
opened from the Animation menu.
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Two animation techniques
•

•

In Camera Path animation a red curve illustrates “flight path” of
the camera, which can be adjusted from the green control nodes
that correspond to items in the Camera Path track. The whole path
can be moved and zoomed by grabbing it elsewhere than at the
nodes. Easy method for creating impressive animations quickly.
In the more traditional Keyframe animation one moves the image
manually to a position, then drags an item for this position to the
Keyframe track, then moves the image to another position, drags
an item for that and so on. The computer then calculates frames
between these keyframes the user has specified.
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Additional features
Resize.

To change the amount of pixels/voxels in a dataset, choose
Resize dataset from the Tasks menu. You can make for instance a large
dataset smaller to make its processing faster. A resized dataset appears red
and marked with * in the file tree. You can toggle between using the original
or the re-sized dataset from the button at the top of the view panel. This
way you can for instance use a smaller version of a dataset while finding out
settings for its processing, but then switch to the original size for the actual
processing. If you want to save the dataset with the new size, click Save
dataset. (If you want to change the bit depth of a dataset, for instance from
16-bit to the recommended 8-bit, choose Change bit depth from the Tasks
menu.) From Preferences in the Edit menu you can set up BioImageXD to
automatically resize large datasets upon loading.

Region Of Interest (ROI).

Using the circular, rectangular and
polygonal drawing tools on the right side of the View panel you can draw
ROIs onto an image (recommended visualization modes: Slices or Maximum
Intensity Projection). You can then use the Procedure list task to for
instance create a smaller dataset consisting of the ROI only (Extract a
subset) or to analyze the pixels/voxels within the ROI (Analyze ROI or FRAP
analysis). Tip: If you want the ROI processing to cover all the channels in a
dataset, you have to use the Batch processor in stead of the Procedure
list task.

Palette.

Typically BioImageXD operates on greyscale images that are
pseudo-colored using palettes (look up tables). You can change the palette
by clicking on the Channel palette color strip in Channel info (visible on the
right when no task is active). This opens a color transfer function editor,
which is basically the same as the corresponding one used for volume
rendering (see above), except that there is no alpha channel. The new
palette is activated when you close the editor. If you want a channel to
have the new palette by default the next time it is opened, click Save
dataset, which creates a new dataset that includes palette information.

Immediate updating.

BioImageXD often updates the screen
automatically when you change some settings. This can be switched off by
un-ticking Immediate view panel updating from the Edit menu. This is
advisable for large datasets or complex procedures especially with slower
computers. When switched off, the screen is only updated when an Apply or
View result button is pressed.
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Saving and opening settings
•
•

When in any task, click Save settings, and current settings are
saved. They can be opened from Open settings while in the same
task again.
Several features of BioImageXD have their own additional
possibilities for saving and opening settings:
o Color transfer function editor in volume rendering or when
adjusting channel palette: Save/open palette (color look-up
table)
o Procedure list task: Save/open procedure lists as Presets
o Batch processor: Save/open batch analysis from File menu
o Animator: Save/open animation project from Animation
menu.

Reference and further information
BioImageXD was published in the July 2012 issue of Nature Methods. Please
use this as a reference to BioImageXD in publications and other work where
BioImageXD has been used:
Kankaanpää P, Paavolainen L, Tiitta S, Karjalainen M, Päivärinne J,
Nieminen J, Marjomäki V, Heino J, White DJ. 2012. BioImageXD: an
open, general-purpose and high-throughput image-processing platform.
Nat Methods. 9(7): 683-689. doi: 10.1038/nmeth.2047.
The paper and its supplementary material offer a lot of further information
on BioImageXD, such as sample data, detailed procedure lists and
instructions for advanced segmentation and motion tracking, and screen
capture videos illustrating how BioImageXD is used.
Additional further information is available on the BioImageXD web site and
wiki: www.bioimagexd.net.

